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Introduction 

Components 

 
SoundSens correlation pods 
SoundSens carry case 
Software CD 
Mains charger 
Download leads 
(1 x Serial, 1 x USB) 
 
 
 
 
 
 
 
 
 
 

 

Concept 

The SoundSens system comprises a powerful software package and the new SoundSens i 
pods which can be setup in the field with or without a PC.  Recordings can be stored in the 
memory of the pod, or the unit can be used with a PC to correlate in the field as a 
multipoint unit carrying out the test straight away or as a delayed test ie: over night. 
 
SoundSens i can store four sets of recording sessions.  This is equivalent to 4 nights of 
data storage.  The SoundSens PC software contains help files for using the PC to setup, 
download and analyse recordings. 
 
 
This manual was written using SoundSens software version 3.2.1 and Radcom SoundSens i sensors. 
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Charging the Carry Case 

The carry case contains rechargeable batteries.  It must be charged for 24 hours before 
first use.  Re-charge the carry case when the battery status LED starts to flash RED.  The 
data will be lost if the unit goes completely flat.  However the battery low LED will give 
plenty of notice of a low battery (i.e. days) and should be seen as an indication to 
download data and re-charge.  
 
The charge in the carry case battery pack should last approximately two months 
depending on how frequently it is used. 
 
To charge the batteries plug the supplied mains charger into the charging socket next to 
the battery status LED.  While charging the LED will flash ORANGE. 
 
When the batteries are charged the battery status LED will flash GREEN (even if the 
charger is still connected). 
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Setting Up SoundSens 

Setup With PC 

Start the software 

 
Run the SoundSens software from the Start 
menu as illustrated here. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
The opening screen for the SoundSens 
software. 
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Connect the carry case to the PC 

 
 
 
 
 
Serial (RS232) Communication Cable 
 
The male end of the cable plugs into the Master 
Serial connector on the carry case, and the female 
end plugs into your laptop or PC. 
 

See next page for further information 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
USB Communication Cable 
 
The A end (rectangle shape) plugs into your PC or 
laptop, and the B end (square shape) plugs into the 
USB connector on the carry case. 
 

 

 
 

This message will appear indicating the 
software has detected the case 
 

See next page for further information 
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Information regarding connection via Serial RS232 

 
When you connect the carry case to your laptop or PC via the Serial (RS232) cable the PC 
will not do anything.  You must select the correct communications port manually. 

 
 
 
From the Tools menu click Options 
 
 
 
 
Then select the Communications tab (see below) 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Select the correct port from the drop down list. 
 
For extra help please see page 54 or contact the Radcom technical support team. 
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Information regarding connection via USB 

 
With the software started connect the SoundSens carry case to the PC using the USB 
communication cable. 
 

This message will appear indicating the 
software has detected the case. 
 

 
 
 
On the Sensor Type drop down menu you can select the following 
 

 
 

• Pre Production Sensor 

• Production Sensor (The original SoundSens logger) 

• Production Sensor II (Dark blue plastic logger) 

• Production Sensor III (Otherwise known as SoundSens i) 
 
 
The port drop down menu is usually picked automatically. 
 

 
 
 

 
Click Select to continue. 
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Information regarding daisy chaining multiple cases together 

 
To communicate with multiple cases you need to connect them together using SoundSens 
serial communication cables, and then via USB to the PC. 
 
The suitcase lid will have an arrangement of D shape communication ports and a USB 
port. 
 
There are variations on the lid as shown below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

In all situations you need to daisy chain the cases as shown below. 
 
 
 
 
 
 
Note: You can not chain together 4 pod kits, but one 4 pod kit can be connected to the end 
of a chain of 8 or 6 pod kits. 
 



 

SoundSens User Guide 
Leak Localisation and correlation 

 

 SoundSens User Guide 
©Radcom (Technologies) Ltd Page 12 of 63 

 

Communication Test 

 
With the carry case (or cases) 
connected to your PC or Laptop 
click the sixth icon on the menu 
bar. 
The software will now 
communicate with the case (or 
cases) and loggers. 
 
The list which pops up shows the 
logger positions in the case.  If any 
loggers have failed to communicate 
they will be missing from this list. 
 
Click Ok. 
 
 

 
 
 

REMEMBER TO SAVE REGULARLY 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click Save Type a name 
for your file. 
 
Make sure the 
file name has 
not been used 
before. 
 

Click Save 

You will only be prompted to type a file name if you have not clicked 
save before. 
 
Every other time you click save the updates will be saved but no 
other action will be required. 
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Quick recording setup 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Connect the carry case to your PC or Laptop. 
 
To setup a quick recording either click the Recording Setup button on the 
Wizard Bar (left image), or click the 7th button on the menu bar (circled 
above). 
 
 
 
 
 
 

 
 
 
This is the Quick Recording Series Setup 
window which will pop up after clicking the 
Recording Setup button. 
 
Quick recording setup is explained in detail 
next. 
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The time line shows a series of logging 
sessions as dark blue lines. (SEE 
DIAGRAM BELOW) 

 
If the time line is red then check the 
“Start Series At Time/Date” values are 
not in the past (SEE NEXT DIAGRAM). 

 
 
It is possible to set a date and time for the 
recording series to start  
NOTE : Do not set a start time more than 36 
hours in the future. 

 
Alternativly you can set the loggers to wait for 
a period of time before starting. 
You can set the waiting time between 1 
minute and 3 hours. 
 
Make sure you have sufficient time to deploy 
the pods before the run starts! 

 
 

 
 
 
 
 
Black line 
indicates the time 
now 

Dark blue lines are 
recording times 

First light blue 
space is Wait time 
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Select the sample period. 
This is determined by the pipe material and 
diameter. 
 
Suggested sample periods for pipe materials 
and lengths are shown below. 

 
Pipe Short distances Metre Long distances Metre Very long  

distances 
 

Up to 6” Metal 10 Seconds 500 10-20 Seconds 1000   

8” +Metal 20 Seconds 400 20-30 Seconds 800   

Up to 6” AC 10 Seconds 100 20 Seconds 500   

8”+ AC 20 Seconds 80 30 Seconds 500   

Up to 4”MDPE?PVC 30 Seconds 50 60 Seconds 100   

4” + MDPE/PVC 60 Seconds 50 120+Seconds 100   

300+Steel   20 Seconds 500 60 Seconds 1000+ 

 
NOTE : On sites with mixed pipe material always select the longest sample period.  So if 
you have some 6” and some 8” Metal (less than 500 metre lengths) select 20 seconds. 
 

 
Set the number of recordings 
(max 9), and set the recording interval 
(between 1 minute and 3 hours) 
 

The recording interval is the gap between the START times of each recording. 
e.g. if three recordings of 1 minute each are set to start at 1AM with a recording interval of 
1 hour then the start times will be 1am, 2am, 3am.  If the recording interval is 15 minutes 
then the start times will be 1am, 1:15am and 1:30 am. 
 
Radcom recommends 3 recordings – see explanation below. 
 
The recording interval needs to be set with local knowledge in mind.  Think of how long it 
takes for a toilet to fill in your local area, and set the recording interval to that time.  This 
will help reduce the detection of noise which is due to legitimate consumption. 
 
This is also partly the reason why we suggest 3 recordings.  If a logger detects a noise 
which can be put down to legitimate usage then hopefully on the second or third recording 
the usage will have stopped.   
 
 

 
Some combinations of sample periods and 
number of recordings will cause excess 
memory usage.  This is due to memory size 
restrictions in the logger. 
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After you are happy with the settings in 
the setup window, click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The SoundSens software should 
communicate with the suitcase. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
The SoundSens software will display this message if the 
setup worked.  Click OK to continue. 
 

 
 

 
Deploy SoundSens correlation pods ( i.e. loggers) on site. 
You should have sufficient time to deploy the pods before the run starts. 
As you deploy make a note of the SERIAL NUMBER of the Pod and it’s location on site. 

CONTINUED… 
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Quick recording setup with Multiple Cases 

 
Connect the suitcases together as shown in the section “Information regarding daisy 
chaining multiple cases together” 
 
Follow the instructions from the section “Quick recording setup”. 
 
At the stage of upload you will notice the software communicates with each suitcase and 
each logger within in turn. 
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After uploading the settings to the loggers the SoundSens software will look something like 
this… 
 

 
 
The next step is to create a pipe layout. 
  
Creating a pipe layout is explained in the Pipe Layout section within the Dealing With Data 
chapter of this manual. 
 
 

REMEMBER TO SAVE REGULARLY (PAGE 8) 

This countdown timer 
shows how much time 
is left before the logging 
starts 
 

The number in 
brackets shows 
how many logging 
sessions are left 

Pipe layout 
menu 

Pipe layout toolbar 

Pipe layout area 
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Setup Without PC 

Basic Carry Case Operation 

 
Please note 

When the carry case is not being used it will switch to a low power standby mode for 
battery conservation, so the carry case display will turn off after 20 seconds if no buttons 
are pressed.  If you are in the middle of making any changes or setting up a recording 
session you will have to start again.   
 
The carry case display can be reactivated by pressing OK, CANCEL, or MODIFY.  The 
first thing you see on the display will always be the time and date – You must check that 
this is correct before setting up a recording.  However the chances of the time being 
wrong are very small because every time the SoundSens software communicates with the 
carry case it will synchronise the time. 
 
In addition to the time/date this screen can also show 
 

• BATTERY LOW (if the battery needs charging) 

• BATTERY CHARGING (when the charger is plugged in) 

• Recording countdown (time until next recordings starts) if neither of the above apply 
and a recording has been set up. 

 
The format for the recording countdown is:  HH:MM:SS (N) 
 

HH  – Hours 
MM  – Minutes 
SS  – Seconds 
N  – Number of recordings remaining 

 
Pressing the MODIFY key cycles through the main options. 
To select an option press OK.   
Pressing CANCEL returns to the time/date screen. 
 
Main options (Press Modify to cycle through): 

• Time/Date 

• Set recording 1? (30min delay) – daytime quick recording setup 

• Set recording 2? (2am start) – overnight quick recording setup 

• Recording setup? – Custom recording setup 

• Download data? 

• Stored data 

• Set time/date 
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Set Time / Date 

 
Setting the time is rarely necessary as the unit contains an accurate clock, and when 
connected to a PC the time and date are updated. 
 

1. Press MODIFY to cycle through the menu options until you see “Set Time / Date”  
2. Press OK to enter edit mode 
3. Use the MODIFY key to change the value 
4. Press OK to move to the next value 

 

Recording options 

 
There are three options for setting up a new recording. 

1. Daytime Quick Recording 
2. Overnight Quick Recording 
3. Custom Recording 

 
This table should assist you in deciding weather one of the pre-programmed sessions will 
be suitable, or if you need to set up a custom recording. 
 
Pipe Short distances Metre Long distances Metre Very long  

distances 
 

Up to 6” Metal 10 Seconds 500 10-20 Seconds 1000   

8” +Metal 20 Seconds 400 20-30 Seconds 800   

Up to 6” AC 10 Seconds 100 20 Seconds 500   

8”+ AC 20 Seconds 80 30 Seconds 500   

Up to 4”MDPE?PVC 30 Seconds 50 60 Seconds 100   

4” + MDPE/PVC 60 Seconds 50 120+Seconds 100   

300+Steel   20 Seconds 500 60 Seconds 1000+ 
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Daytime Quick Recording Setup 

 
This sets up a recording session which will start after a 30 minute delay.  Three recordings 
will be made each 20 seconds long, five minutes apart. 
 
 Delay to start of recording:  30 min 
 Interval between recordings: 5 min 
 Length or each recording:  20 sec 
 Number of recordings:  3 
 
Check the table at the bottom of this page to see if it is suitable for your test. 
 

1. Press MODIFY to cycle through the menu options until you see “Set recording 1”  
2. Press OK to setup the quick recording 

 
If the loggers contain any data then it will be downloaded before the new recording is set 
up.  This ensures that the data in the loggers cannot be lost accidentally by setting up a 
new recording. All recordings will be available for download in the SoundSens software. 
 
When the recording setup is complete the screen will show a confirmation message, e.g. 
 
 
 
The number of loggers programmed is displayed, and the right side of the screen shows a 
map of the positions of the programmed pods (‘O’ represents a logger present and a ‘-‘ 
shows a vacant position).  If this differs from the actual positions of the loggers below the 
most likely explanation is that the windows on top of the pods are dirty or that an object is 
on top of the loggers. 
 
Pipe Short distances Metre Long distances Metre Very long  

distances 
 

Up to 6” Metal 10 Seconds 500 10-20 Seconds 1000   

8” +Metal 20 Seconds 400 20-30 Seconds 800   

Up to 6” AC 10 Seconds 100 20 Seconds 500   

8”+ AC 20 Seconds 80 30 Seconds 500   

Up to 4”MDPE?PVC 30 Seconds 50 60 Seconds 100   

4” + MDPE/PVC 60 Seconds 50 120+Seconds 100   

300+Steel   20 Seconds 500 60 Seconds 1000+ 

 

4 LOGGERS   -O—- 

PROGRAMMED  -OOO 
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Overnight Quick Recording Setup 

 
This sets up a recording session which will start at 2am.  Three recordings will be made 
each 20 seconds long, one hour apart. 
 
 Recording start time:  2 am 
 Interval between recordings: 1 hour 
 Length or each recording:  20 sec 
 Number of recordings:  3 
 
Check the table at the bottom of this page to see if it is suitable for your test. 
 

1. Press MODIFY to cycle through the menu options until you see “Set recording 2” 
2. Press OK to start the recording setup 

 
If the loggers contain any data then it will be downloaded before the new recording is set 
up.  This ensures that the data in the loggers cannot be lost accidentally by setting up a 
new recording. All recordings will be available for download in the SoundSens software. 
 
When the recording setup is complete the screen will show a confirmation message, e.g. 
 
 
 
The number of loggers programmed is displayed, and the right side of the screen shows a 
map of the positions of the programmed pods (‘O’ represents a logger present and a ‘-‘ 
shows a vacant position).  If this differs from the actual positions of the loggers below the 
most likely explanation is that the windows on top of the pods are dirty or that an object is 
on top of the loggers. 
 
Pipe Short distances Metre Long distances Metre Very long  

distances 
 

Up to 6” Metal 10 Seconds 500 10-20 Seconds 1000   

8” +Metal 20 Seconds 400 20-30 Seconds 800   

Up to 6” AC 10 Seconds 100 20 Seconds 500   

8”+ AC 20 Seconds 80 30 Seconds 500   

Up to 4”MDPE?PVC 30 Seconds 50 60 Seconds 100   

4” + MDPE/PVC 60 Seconds 50 120+Seconds 100   

300+Steel   20 Seconds 500 60 Seconds 1000+ 

 

4 LOGGERS   -O—- 

PROGRAMMED  -OOO 
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Custom Recording Setup 

 
This option sets up a recording with user-defined settings. 
 

1. Press MODIFY to cycle through the menu options until you see “Recording Setup” 
2. Press OK to start 
3. For each setting number use the MODIFY key to change the value 
4. Press OK to move to the next setting 

 
The options available are: 
 

1. Recording Start Delay 

• 1,5,10,15,30 or 60 minutes 

• At the beginning of an hour (press modify to cycle through) 
 

2. Length Of Each Recording 

• 10, 20, 30 or 60 seconds 
 

3. Recording Interval (time between recordings) 

• 1, 2, 5, 10, 15, 20, 30, 45 or 60 minutes 
 
4. Number Of Recordings 

• 10, 20, 30 or 60 seconds 
 
This table should assist in selecting the recording options you need. 
 
Pipe Short distances Metre Long distances Metre Very long  

distances 
 

Up to 6” Metal 10 Seconds 500 10-20 Seconds 1000   

8” +Metal 20 Seconds 400 20-30 Seconds 800   

Up to 6” AC 10 Seconds 100 20 Seconds 500   

8”+ AC 20 Seconds 80 30 Seconds 500   

Up to 4”MDPE?PVC 30 Seconds 50 60 Seconds 100   

4” + MDPE/PVC 60 Seconds 50 120+Seconds 100   

300+Steel   20 Seconds 500 60 Seconds 1000+ 

 
NOTE : On sites with mixed pipe material always select the longest sample period.  So if 
you have some 6” and some 8” Metal (less than 500 metre lengths) select 20 seconds. 
 
The recording interval needs to be set with local knowledge in mind.  Think of how long it 
takes for a toilet to fill in your local area, and set the recording interval to that time.  This 
will help reduce the detection of noise which is due to legitimate consumption. 
 
This is also partly the reason why we suggest 3 recordings.  If a logger detects a noise 
which can be put down to legitimate usage then hopefully on the second or third recording 
the usage will have stopped.   
 

Continued… 
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For the last setting, ‘number of recordings’, if a value is selected that uses more than the 
available memory in the logger then exclamation marks will be shown as a warning.  For 
example if the recoding length is set to 60 seconds and the number of recordings is set to 
4 then the display will show: 
 
 
 
 
The exclamation marks show that the logger memory will overflow if this combination of 
settings is used.  In this situation, use a lower number of recordings or a shorted recording 
time. 
 
If the loggers contain any data then it will be downloaded before the new recording is set 
up.  This ensures that the data in the loggers cannot be lost accidentally by setting up a 
new recording. All recordings will be available for download in the SoundSens software. 

NUMBER OF       

RECORDINGS:4 !!  
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Downloading Data To The Carry Case 

Data can be held in the carry case and downloaded to a PC or Laptop at a later stage.  To 
download data after a recording: 
 

1. Place the pods back into the case (in any order or position) and lower the front 
panel. 

2. Press MODIFY to cycle through the menu options until you see “Download Data” 
3. Press OK to start the download 

 
A message will be displayed during data transfer.  After downloading data from the pods a 
confirmation message is shown.  This is the same format used after setting up a recording 
and shows which loggers have transferred data. 
 
 
 

Viewing Stored Data Details 

 
This option shows a summary of data sets stored in the SoundSens i.  A ‘set’ is the 
collection of data transferred during a download.  The summary shows the set number, 
number of pods used and the start time of the first recording, e.g. 
 
 
 
 
 

1. Select the Stored Data? option with MODIFY 
2. Press OK to view the summary for the first set 
3. Press OK to view the next set 

 
When all sets have been displayed there is an option to delete the last set.  Note the 
delete operation cannot be undone. 
 

1. Select the Stored Data? option with MODIFY 
2. Press OK until all the sets have been seen and the message “Remove last set” is 

shown 
To delete the data use the MODIFY key to select YES then press OK 
 

Memory Capacity 

 
There is enough memory in the case to hold 4 downloads from 8 SoundSens i correlator 
pods which are full of data.  When the case and all the pods are full of data you will not be 
able to record any more and you will see “Memory Full” on the display.  Either download 
the data to a PC or erase some data from the View Data menu. 
One pod will hold approximately 120 seconds of data. 

DOWNLOAD    ---- 

COMPLETE    -OO- 

SET: 02 PODS: 06 

 09:50 20/02/07  
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SoundSens Case User Interface 

Summary 

 

Time and Date 

Set Recording 1? 
(30 Min Delay) 

Set recording 2? 
(2 am Start) 

Recording Setup? 
(OK) To Start 

 

Download Data 
(OK)  To Start 

 

Press any key to 
wake up display.  
 
First screen is always 
Time and Date 

Press Modify 

Press Modify 

Press Modify 

Press Modify 

Pressing Modify 
returns to 
Time and Date 

Stored  Data 
(OK)  To View 

 

Press Modify 

Press OK to select an 
item. 
Further explanation 
below. 

Set Time/Date 
(OK)  To Start 

Press Modify 
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Set Recording 1 (30 Minute Delay) 

 

Please Note: 
When the loggers have been programmed the display 
will switch off after 20 seconds to save battery power. 
 
Wake up the display by pressing any key.  It should 
show the current recording session countdown time, or 
the time and date if recordings have finished. 

The display will then change to a 
countdown timer showing the time until the 
recording starts and the number of 
recordings left (number in brackets). 

The display will 
show 

Press OK 

Time and Date 
Displayed 

Set Recording 1 (30 Min Delay) 
 
Press any key to wake up display. 
Time and Date should be displayed. 
 
Press MODIFY once 
Display should read… 
 

 Set Recording 1? 
(30 Min Delay) 

Setting up 
recordings 

Followed by 

8 Loggers      0000 
Programmed 0000 

The number of loggers programmed 
depends on the number of loggers in the 
case.   
Each 0 shown on the right represents a 
logger in the case. 

14 :31 04/02/07 
Rec 00:00:00  (3) 

If a recording is taking place 
then the display will show the 
following message. 

14 :31 04/02/07 
Recording in progress 

A recording session will be set up 
with the following settings… 
 
3 Recordings 
20sec Duration 
5 min Intervals 
 
This is not shown on the display. 
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Set Recording 2 (2am Start) 

 

Please Note: 
When the loggers have been programmed the display 
will switch off after 20 seconds to save battery power. 
 
Wake up the display by pressing any key.  It should 
show the current recording session countdown time, or 
the time and date if recordings have finished. 

The display will then change to a 
countdown timer showing the time until the 
recording starts and the number of 
recordings left (number in brackets). 

The display will 
show 

Press OK 

Time and Date 
Displayed 

Set Recording 2 (2 am Start) 
 
Press any key to wake up display. 
Time and Date should be displayed. 
 
Press MODIFY twice 
Display should read… 
 

Set recording 2? 
(2 am Start) 

Setting up 
recordings 

Followed by 

8 Loggers      0000 
Programmed 0000 

The number of loggers programmed 
depends on the number of loggers in the 
case.   
Each 0 shown on the right represents a 
logger in the case. 

14 :31 04/02/07 
Rec 00:00:00  (3) 

If a recording is taking place 
then the display will show the 
following message. 

14 :31 04/02/07 
Recording in progress 

A recording session will be set up 
with the following settings… 
 
3 Recordings 
20sec Duration 
1 hour Intervals 
 
This is not shown on the display. 
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Set User Defined Recording 

 

Followed by 

Press OK to accept 
Display will show 

Press OK to accept 
Display will show 

Press OK to accept 
Display will show 

Press OK to accept 
Display will show 

Press OK 
Display will show 

Time and Date 
Displayed 

Set User Defined Recording 
 
Press any key to wake up display. 
Time and Date should be displayed. 
 
Press MODIFY three times 
Display should read… 
 

Recording Setup? 
(OK) To Start 

 

Recording Start 
Delay  01Min 

Length of each 
Recording 

Recording Interval 
Delay 01Min 

Number of 
Recording :3 

Setting up 
Recording 

8 Loggers      0000 
Programmed 0000 

The number of loggers programmed 
depends on the number of loggers in the 
case.   
Each 0 shown on the right represents a 
logger in the case. 

After the loggers have been 
programmed the display will change to 
a countdown timer showing the time 
until the recording starts and the 
number of recordings left (number in 
brackets). 

14 :31 04/02/07 
Rec 00:00:00  (3) 

If a recording is taking place 
then the display will show the 
following message. 

14 :31 04/02/07 
Recording in progress 

Please Note: 
When the loggers have been programmed the display 
will switch off after 20 seconds to save battery power. 
 
Wake up the display by pressing any key.  It should 
show the current recording session countdown time, or 
the time and date if recordings have finished. 
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Download Data From Loggers to Carry Case 

 

Followed by 

Press OK 
Display will show 

Time and Date 
Displayed 

Download Data 
 
Press any key to wake up display. 
Time and Date should be displayed. 
 
Press MODIFY four times 
Display should read… 
 

Download Data 
(OK)  To Start 

 

Downloading From 
Loggers… 

Downloading 0000 
Complete      0000 

The number of loggers downloaded in the case is represented 
by a 0 shown on the right hand side of the display. 

When the download data option is used, the data is read from 
the loggers and held in the memory of the case.  It can then be 
downloaded to the SoundSens software at a later stage. 
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View Stored Data 

 

Press OK 
Display will return to 

Press MODIFY 
Display will show 

Press OK 
Display will show 

Press OK 
Display will show 

View Stored Data 
 
Press any key to wake up display. 
Time and Date should be displayed. 
 
Press MODIFY five times 
Display should read… 
 

Stored  Data 
(OK)  To View 

Press OK 
Display will show 

Set : 01  PODS : 08 
17:09 30/01/07 

This indicates that the first 
recording in the memory of the 
case had 8 loggers and was 
recorded on 30/1/07 at 17:09 

Set : 02  PODS : 08 
17:49 30/01/07 

Remove Last Set 
Yes  (--No--) 

Remove Last Set 
(--Yes- -)  No 

Stored  Data 
(OK)  To View 

Press OK 
Display will show 

Set 
Removed 

And then the display 
will return to 

Stored  Data 
(OK)  To View 

Here you have the option of 
deleting the last recording held 
in the case.  By default NO is 
selected.  If you want to delete 
the last recording press Modify 
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Set Time and Data 

 

Press OK 

Press Modify to change value 

Then press OK 

Press Modify to change value 

Then press OK 

Press Modify to change value 

Then press OK 

Press Modify to change value 

Then press OK 

Time and Date 
Displayed 

Set Hour 

Set Minutes 

Set Year 

Set Month 

Set Day 

Then press OK to set the time. 

Set Time and Date 
 
Press any key to wake up display. 
Time and Date should be displayed. 
 
Press MODIFY six times 
Display should read… 
 

Set Time/Date 
(OK)  To Start 
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Dealing With Data 

Creating A Pipe Layout 

It is possible to either create a basic schematic layout of the underground pipe work, or 
add a background image for illustration purposes. 
 
 

Pipe Layout Menu 

 
 
 

Add map / 
background image 

Show / Hide pipe layout toolbar 

Move pipe layout items 

Adjust zoom level 

Logger correlation 
selection 
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Add a background image (optional) 

 Click the Add Map / Background Image button. 
 
Click Browse and use the standard 
windows explorer interface to locate a 
bitmap (bmp) file to use as a 
background. 
 
You must click the “Display Bitmap” tick 
box for it to appear on the layout.  By 
default it is not ticked. 
 
At a later stage you can go back to this 
menu and un-tick this option to remove 
the map. 
 
 

 
SoundSens software shown below with map background image. 
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Pipe Layout Toolbar 

 
 
 
 
The pipe layout toolbar at the bottom of the pipe layout area shows Pipe, Join, Text 
Comment and the serial of each logger used. 

Putting loggers on the map 

Start by selecting a logger and with the mouse button held down drag and drop it from the 
toolbar onto the pipe layout area.   It is not important to place the loggers precisely as the 
software pays no attention to position on the screen.  The most important data is pipe 
length and material type which is entered later. 
 

 
 
 
 
 
 
 

Putting joins on the map 

To add a join on the map click once on Join and then click once on each place that 
you need a join.  Only use a join 

for a 
change in pipe direction, or pipe material. 

REMEMBER TO SAVE REGULARLY (PAGE 8) 
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Putting text comments on the map 

To add a text comment click Text Comment and then click on the map where you wish to 
see a text comment. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Add your text comment, choose the angle you wish and then click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Type your text comment here, and pick a text direction, then click OK 
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Adding connecting pipe work to the map 

After dragging and dropping the loggers onto the pipe layout area and adding the join 
points you can start adding the connecting pipes. 
 

 
Click the pipe icon once and then move the mouse pointer over one of the loggers.  Click 
and hold the mouse button down over the first logger and then move the mouse to the 
logger you wish to connect it to. 

 
 
Selecting a material from the drop down list 
will set a sound velocity.  Un-tick “Select from 
materials database” to enter your own sound 
velocity. 
 
. 
 
 
 
 

Enter the pipe length 

Select the pipe diameter 
from the drop down menu 
 

Click OK 
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Changing Properties on Pipe Layout 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

Right click on the pipe you want to 
change and select Pipe Properties 
from the menu. 

Change the pipe length here 

Change the pipe diameter 
from the drop down menu here 
 

Click OK to keep the changes 
or Cancel to leave unchanged. 

Change the pipe material here 

REMEMBER TO SAVE REGULARLY (PAGE 8) 
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Download loggers 

 
The loggers can be collected when the recordings have finished. 
 
If you leave the SoundSens software running then you will see the following information to 
help you tell when the recordings are being done, and when they are finished. 
 

 
 

 
 
 
 
 
Note : When the loggers are put back in the case for downloading they can go back in any 
order. 
 

 
 
With the SoundSens software running and the USB cable 
connected between the laptop and the suitcase click the 
Download button. 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

 

Time shows how long until the recording 
starts.  The number in brackets shows how 
many recordings are left to do. 

When is says No Scheduled Recordings it 
means all the recordings have been finished.  
The SoundSens software must be left running 
for this to work.  If the software is stopped 
then the counter will reset back to showing No 
Scheduled Recordings. 

If any fail to communicate you 
will see this error message. 
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Downloading Loggers (Multiple Suitcases) 

 
Connect the suitcases together as shown in the section “Information regarding daisy 
chaining multiple cases together” 
 
Connect the USB cable to the first suitcase. 
 
Click the Download button. 
 
The software will ask for conformation about the number of cases.  If this number is 
incorrect ensure the USB cable is connected to the first suitcase, and that all the cases are 
connected together correctly. 
 
If the number of cases is correct then the download can begin.  After each box of loggers 
has been downloaded the software will ask for the USB cable to be moved to the next box 
in the line.  This process will be repeated until all the connected boxes have been 
downloaded. 
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Correlation 

 
After the data has been downloaded correlation begins automatically. 
 

 
 
 

    
 
 
To begin the correlation process manually after opening a data file click the Perform 
Correlation button, or click Correlate on the left menu bar. 
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After correlation has finished 
the software sorts the data. 
The most likely leak 
correlations will be at the top. 
 

The location of each possible 
leak is marked on the map 
by red markers. 
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Double click on the recording graph to see a close up view. 
 

Click once on the recording graph and the blue circles will indicate which two loggers 
have been correlated between. 
A third smaller blue circle will show the possible leak location 

Click once on recording 
graph. 
Loggers circled. 

Possible leak location 
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The Basic Recording Graph 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

Two logger serial 
numbers between 
which correlation has 
taken place 
(Logger 1 > Logger 2) Leak location shown as distance from logger 1. 

Logger 1 Logger 2 

Leak distance from logger 1 and logger 2 

Distance between loggers 
Sound velocity shown in brackets 
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Recording Graph Advance Features 

 
Zoom functions 

 
 
 
 
 
 
 
 
 

Listen to recordings from loggers 
 
 
 
 
 
 
 
 
 
 
 

Graph viewing options 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Zoom X – Zoom Y – Zoom XY – Zoom Out One Step – Zoom Out Fully 

Left logger – Both loggers – Right logger – Stop playback 

If two or more graphs are being 
viewed this drop down menu 
selects which one is on top. 

If two or more graphs are being 
viewed this button cycles 
through them putting each one 
on top in turn. 

This drop down menu 
reduces the number of 
graphs on the screen. 
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Reveal Advanced Graph Options 
 

 
Click the small up arrow on the bottom left of the graph to reveal the advance graph 

options (see below) 
 

 
 
 

 
 
 

 
 
To see the correlation graph between two different loggers just change the serial numbers 
shown in the drop down menus for logger 1 and logger 2, and then click Apply. 
 
To superimpose another recording taken between the same two loggers over the existing 
graph, select it from the time and date drop down menu and then click Apply. 
 
To change the Band Pass Filter, adjust the figures and then click Apply. 
 

Logger 1 
Serial number 

Date and time of recording 

Logger 2 
Serial number 
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SoundSens Software Advanced Configuration 

 
 
 

The General tab 

 
 
 
 
 

 
 

Ticking this box 
makes the software fill 
the screen when it is 
started 

Ticking this box 
makes the software 
auto save your work 

Wizard bar 
The blue bar found on the left 
hand side of the screen 

Help bar 
Found on the right hand side 
of the screen 

From the Tools menu click Options. 
 
This is intended as a general guide 
to the SoundSens software options. 
For further assistance and 
explanation please contact the 
Radcom technical support team. 

Software start up options. 
These changes will take effect next time the software is started. 
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The General tab (continued) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Start the SoundSens software in Advanced or 
Normal mode.   
In Advanced mode you will see options such as 
those seen at the bottom of the correlation graph 

Change the measurement units 
between metric and imperial 

The location of the pipe 
materials database 

The default location 
for the SoundSens 
data files 
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The Communications tab 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Set the default sensor 
(logger) type 

Set the default 
communication port 



 

SoundSens User Guide 
Leak Localisation and correlation 

 

 SoundSens User Guide 
©Radcom (Technologies) Ltd Page 50 of 63 

 

The Recording Defaults tab 

 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The default recording options. 
 

Change the Notch filter value for filtering out 
mains frequency interference.  This is set when 
the software is installed, but can be changed 
here (for UK it should be set to 50Hz) 

These are the default recording durations for 
selected pipe materials.  You can change them 
to suit your area.  For further information please 
contact the Radcom technical support team. 
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The Pipe Layout tab 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The pipe layout area options 
 

To change the colour of the pipes on the pipe 
layout double click on the coloured area. 
 
Select a new colour from the menu which pops 
up on the screen, and then click OK 



 

SoundSens User Guide 
Leak Localisation and correlation 

 

 SoundSens User Guide 
©Radcom (Technologies) Ltd Page 52 of 63 

 

The Correlation tab 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Mid peak suppression 
If the logger hears nothing then it 
may put a large peak in the centre of 
the correlation graph.  This option will 
prevent it from happening 

By default only one peak will be 
highlighted with it’s value 
displayed on the graph.  You can 
change this to a higher number if 
preferred. 

Change the default colours of your leak 
location and out of bracket markers here. 
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The Exhaustive Correlation tab 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The default option here is All Recordings.  This will perform correlation using all 
the recordings in the loggers. 
 
Use Pop-up Significant Correlations to automatically display the graph or graphs 
for locations most likely to have leaks. 

The 'All Logger Pairs' options specify weather to 
correlate every logger with every other logger in 
the layout, or perform sufficient correlations to 
ensure full pipe network coverage.  By default 
these boxes are not ticked. 
 
Exhaustive correlation using 'All Logger Pairs' may 
take significantly longer on a large pipe network. 
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The Graph Colours tab 

 
To access the tabs past Exhaustive Correlation you need to click the right hand arrow as 
indicated on this diagram 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Configures the styles and colours used to display 
data graphs as well as fonts for axis and graph text.  
Select Defaults to return to the default settings. 

Click any of the buttons to change a colour 

Select a new line colour and 
style, and then click OK 
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The Graph Options tab 

 
Configures the functionality of the graph. 
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Troubleshooting 
 

Carry Case Not Communicating with PC or Laptop 

 
Using Serial (RS232) Cable 
Check the communications port. 
Tool -> Options -> Communications tab 

 
 

Incorrect Sensor Type 

 
If the wrong sensor type is selected you may see an 
error during communication. 
 
Change the sensor type from the drop down menu 
 
 

The options are 
 

• Pre Production Sensor 

• Production Sensor (The original SoundSens logger) 

• Production Sensor II (Dark blue plastic logger) 

• Production Sensor III (Otherwise known as SoundSens i) 
 

Change the communications port number by 
clicking the drop down menu and selecting a 
different one. 
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Change Sensor Type 

 
 
 
 
 
From the Tools menu click Options 
 
 
 
 
 
 
 
 
 
 
Click the Communications tab 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The currently selected sensor 
Is shown here 
 
 
 
 
To change the sensor type 
follow the next instruction 
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Click the drop down menu and 
click on the type of sensor you 
have. 
 
 

The options are 
 

• Pre Production Sensor 

• Production Sensor (The original SoundSens logger) 

• Production Sensor II (Dark blue plastic logger) 

• Production Sensor III (Otherwise known as SoundSens i) 
 

 
 
 
 
 
After making your selection click 
OK to save the change. 
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SoundSens Software 

License Agreement 
Carefully read all the terms and conditions of this agreement prior to using this SoundSens Software. By attempting to load the Software 
you indicate your acceptance of these terms and conditions.  
 
License: You have the non-exclusive right to use the enclosed Program on a single CPU. You may physically transfer the Program from 
one CPU to another provided that only the licensed company uses the Program. You may not distribute copies of the Program or related 
documentation to others. You may not modify or translate the Program or related documentation without the prior written consent of 
Radcom. You may not use, copy, modify or transfer the Program or documentation, or any copy thereof, or permit anyone else to do so, 
except as expressly provided in this agreement.  
Back-up and Transfer: You may make one (1) copy of the Program solely for your own back-up purposes. You must reproduce and 
include the copyright notice on the back-up copy. Transfer of Program and license to another party may only be made after written 
approval from Radcom, provided the other party agrees to the terms and conditions of this agreement and completes and returns a 
Product Registration Form to Radcom. If you transfer the Program you must at the same time transfer the documentation and back-up 
copies or transfer the documentation and destroy the back-up copies.  
Copyright: The Program and its related documentation are copyrighted. You may not copy the Program or its documentation except for 
your own back-up purposes and to load the Program into the computer as part of executing the Program. All other copies of the 
Program and its documentation are in violation of this Agreement.  
Terms: This license is effective until terminated. You may terminate it by destroying the Program and documentation and all copies 
thereof. The license will also terminate if you fail to comply with any term or condition of this Agreement. You agree upon such 
termination to destroy all copies of the Program and documentation.  
Warranty: Radcom warrants to the original licensee that the diskettes on which the Program is recorded be free from defects in 
materials and workmanship under normal use and service for a period of 90 days from the date of delivery to you as evidence by a copy 
of your invoice. During this period Radcom warrants that each program, which is designated by Radcom, as warranted in its program 
specifications, supplied with the program, will conform to such specifications provided that the program is properly used on the machine 
for which it was designed. If you believe that there is a defect in a warranted program such that it does not meet its specifications, you 
should notify Radcom within the warranty period (the warranty period may be extended by signing a software update agreement with 
Radcom) in a manner set forth in the program specification.  
All back up copies are provided “as is” without warranty of any kind, either express or implied. The entire risk as to quality and 
performance of the Program is with you. Should the Program prove defective, you assume the entire cost of all necessary servicing, 
repair or correction. Radcom does not warrant that the functions contained in any program will meet your requirements or that the 
operation of the Program will be uninterrupted or error-free or that the programs defects will be corrected.  
The foregoing warranties are in lieu of all other warranties, express or implied, including but not limited to, the implied warranties of 
merchantability and fitness for a particular purpose. Radcom is not responsible for problems caused by changes made after the 
publication of the software in the operating characteristics of the computer hardware, test instruments or operating systems, nor for 
problems in the interaction of the Program with non-Radcom software components.  
Limitation of Remedies: Radcom’s entire liability and your exclusive remedy shall be as follows:  
a. With respect to defective media during the warranty period, Radcom will replace media not meeting Radcom’s  
“limited warranty”, if returned to Radcom with a copy of your receipt.  
b. With respect to warranted programs, in all situations involving performance or non-performance during the warranty  
period, your remedy is (1) the correction or bypass by Radcom of program defects or (2) if, after repeated efforts,  
Radcom is unable to make the Program operate as warranted, you shall be entitled to a refund of the money paid.  
In no event will Radcom be liable to you for any lost profits, lost saving or other incidental or consequential damages arising out of the 
inability to use any program even if Radcom have been advised of the possibility of such damages, or for any claim by any other party.  
Update Policy: In order to be able to obtain updates of the Program during the warranty period, the licensee and persons to whom the 
Program is transferred in accordance with this agreement must complete and return the attached User Registration Form to Radcom. If 
this registration form has not been received by Radcom, Radcom is under no obligation to make available to you any updates.  
Miscellaneous: This license agreement shall be governed by the laws of England and shall inure to the benefit of Radcom, its assigns 
and successors.  
Acknowledgement: You acknowledge that you have read this agreement, understand it, and agree to be bound by its terms and 
conditions. You also agree that this agreement is the complete and exclusive statement between the parties and supersedes all 
proposals or prior agreements, verbal or written, and any other communications between the parties relating to the subject matter of this 
agreement.  
Should you have any questions concerning this agreement, please contact Radcom in writing at the relevant address:  

 
RADCOM (Technologies) Ltd. 
Sentry House, 10 Romsey Industrial Park, 
Greatbridge Road, Romsey 
Hampshire SO51 0HR 
Tel: +44 (0)1794 528 700   ●   Fax: +44 (0)1794 528 760 
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Installation Instructions 

 
 
Put the CD in your PC drive, and 
double click the “installer” icon 
 
 
 
 
 
 

 
 
 
The Radcom Software Installer 
window will pop up.  Click the 
SoundSens button. 
 
 
 
 
 
 
 
 
 

 
 
 
 
When the Installation Wizard 
begins click Next to continue. 
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Agree to the license, and then click 
next. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If you wish to change the location 
of the installed files you may do so 
here.  Click next to continue. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click install to continue. 
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Select notch filter value for 
electrical noise rejection.  By 
default 50Hz is selected for the 
United Kingdom.  Then click next. 
 
 
(this option can be changed from 
within the software after 
installation. 
Tools -> Options -> Pipe Layout) 
 
 
 
 
 
 
Click Finish to complete the 
installation. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Finally close the Radcom Software 
Installer. 
 
Please now follow the USB 
driver instructions. 
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USB Driver Installation Instructions 

If you are installing the SoundSens software on a PC which has never had a USB 
SoundSens case connected to it, you should install the USB driver. 

 
From the installation CD double click the 
“USB Drivers” folder. 
 
 
 
 
 
 
 
 
 
Double click the “PreInstaller” icon. 
 
 
 
 
 
 
 
 
 
 
 
 

 
Click Install to “install” the driver. 
 
 
 
 
 

 
The PreInstaller program will display this message if the driver 
installs correctly.  Click OK to continue. 
 
 


